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Overview
StatTrak for Volleyball is a volleyball statistics management system for 
league, tournament, and individual teams.    Keeps records for up to 100 
teams per directory.    Tracks team and player statistics, team record, match 
results, and team standings.    All StatTrak reports can be computed for any 
combination of matches.    You can design and save any number of    player 
statistics report formats, name additional categories, and sort on any 
category.    Reports can be printed or saved to disk.    This program will be 
upgraded every year!

Unless this is a demo (shareware) version of StatTrak for Volleyball, you must
have either purchased it from an authorized retail outlet or directly from ALL-
PRO Software.    Otherwise, you must immediately register with ALL-PRO 
Software or delete the program.    See the Registration Section for 
registration details and benefits.
Start the program and select one or more teams.    Select Update from the 
Main Menu to update match and player results.    Player results can be 
entered from your score book or you can increment totals as the match is 
being played.    Select Reports from the Main Menu to display and print the 
team and player statistics, team record, match results, and team standings 
reports.
Back up your data regularly to protect against loss due to power failure, disk 
damage, or other mishaps.    This is very important!



First Match
To add your first match, select "Team 1", or another team,    from the list of 
teams.    Then from the Update Menu, select Team Name and assign the team
name, select Roster and add players to the roster, and then select Matches 
and add the match and player results for the first match.    When adding a 
match, all match and player results are optional and can be added, changed,
or deleted at a later time.
You might want to set up your match types (league ,tournament, practice, 
etc.), name additional categories you wish to track, and change your data 
directory before adding your first match.    Select Name Your Own from the 
Options Menu to set up your match types and name additional categories.    
Select Data Directory from the File Menu to select the directory you want to 
store your team and player files.



Select Teams
StatTrak lets you select one or more teams on the team list.    If you select 
more than one team, only the first team selected on the list can be updated.  
However, you can report on more than one team at a time.    If you select 
more than one team, the Match Scores and Record options on the Reports 
Menu will be disabled.    If you select just one team, the Standings menu 
option will be disabled.    The Players menu option is available regardless of 
how many teams you select.
To select multiple teams, click and drag on the team list.    The Shift+click or 
Shift+arrow key extends the selection from the previously selected item to 
the current item.    Ctrl+click selects or deselects an item on the list.



File
Selecting File from the Main Menu provides the following menu options:

Data Directory - Select team and player file directory.
Back Up Files - Back up team and player files.
Restore Files - Restore team and player files.
Exit Program - Exit StatTrak for Volleyball program.



Back Up Files
Select Back Up Files from the File Menu to make a copy of your team and 
player files for the current working directory.    You might want to make a 
backup copy to a floppy disk and to your hard drive.    This way you have a 
backup copy you can quickly restore from on your hard drive and a copy on a
floppy disk that you can use should you ever experience problems with your 
hard drive.
If you plan to run StatTrak for Volleyball on two computers, like home and 
work, you can back up your team and player files to a floppy disk and then 
load them to the other computer using the restore function.
StatTrak will NOT make a directory for you.    You must do it.



Restore Files
Select Restore Files from the File Menu to load a backup of your team and 
player files to the current working directory.    You can restore from a backup 
made to a floppy disk or another directory on your hard drive.
If you plan to run StatTrak for Volleyball on two computers, like home and 
work, you can back up your team and player files to a floppy disk and then 
load them to the other computer using the restore function.
StatTrak will NOT make a directory for you.    You must do it.



Help
Select Contents... from the Help Menu to run the StatTrak for Volleyball Help 
Program.    Select About from the Help Menu to view the About Screen which 
shows the All-Pro Software address, toll free phone number for orders, 
technical support and international phone number, fax number, email 
address, and home page address on the InterNet.



Reports
To display reports, select one or more teams, select Reports from the Main 
Menu, and then select one of the following menu options:

Players - Team and Player Statistics Report.
Match Scores - Match Scores Report (if one team selected).
Record - Team Record Report (if one team selected).
Standings - Team Standings Report (if two or more teams selected).

ALL StatTrak reports can be computed for any combination of matches (all 
matches, last 10 matches, matches 5 through 10, league matches, etc.) and 
can be printed or saved to a disk file.



Team and Player Statistics Report
Select    Players from the Reports Menu to display team and player statistics.  
The reports will show players from one or more teams depending on the 
number of teams selected.
Click Print to print the report or save it to a disk file.    Click Compute to 
compute the report for different matches.    Click Sort to sort the report on 
any category in ascending or descending order.    Click Format to select, add, 
change, or delete a report format.    You can select the categories you want 
on the report in the left to right order you want them.    Select one category 
to create a category report.    You can create any number of report formats.    
Click Player to display an individual's match by match statistics.    Click 
Minimum to divide the report into two groups based on a minimum number 
of games played (G), matches played (M), serves (Srv), or attack attempts 
(Att).
Use the vertical and horizontal scroll bars to scroll up/down and left/right on 
the report.    The scroll bars will only appear if scrolling is needed.    For 
example, if only three players appear on the report, the vertical scroll bar will
not be visible.
See Team and Player Statistics for a list of all categories that can appear on 
the reports and how they're calculated.
To view career statistics for a player, select two or more teams and then 
bring up the Team and Player Statistics Report.    Then click Compute and 
enter a player's name or number and click OK. The report will display a 
statistics line for each team the player appeared in as well as a total line.    
For example, if Jeff Elwood played on the 1995 Warriors and the 1996 
Warriors, you would select both teams, bring up the Team and Player 
Statistics Report, and then recompute the report for Jeff Elwood to see his 
1995, 1996, and career statistics.



Match Scores Report
Select Match Scores from the Reports Menu to display match results for the 
selected team.    The report is only available if one team was selected.    The 
Match Scores menu option will be disabled if two or more teams were 
selected.
Click Print to print the report or save it to a disk file .    Click Compute to 
compute the report for different matches.      Click Short to display a one line 
match description which displays match number, date, match type, 
opponents, and the match score.    Click Long to display a more detailed 
match description which also shows the location, individual game scores, and
a match comment.    Both reports can be printed.



Team Record Report
Select Record from the Reports Menu to display the won/lost record for the 
selected team.    The report is only available if one team was selected.    The 
Record menu option will be disabled if two or more teams were selected.
Match wins/losses (M W/L), match win percentage (M Pct), game wins/losses 
(G W/L), game win percentage (G Pct), points for (PF), and points against (PA)
are displayed for each match type that has recorded matches and for total 
matches.    Points for are the points the selected team has scored and points 
against are the points allowed by the selected team.    Ties will only be 
displayed if ties exist.
Win percentage in computed as ((wins + ties) / total games or matches) 
where wins are 1 point, ties are 1/2 point, and total games/matches are 1 
point per game/match.
Click Print to print the report or save it to a disk file.    Click Compute to 
compute the report for different matches.



Team Standings Report
Select Standings from the Reports Menu to display team standings.    The 
report is only available if two or more teams were selected.    The Standings 
menu option will be disabled if less than two teams were selected.
Teams are listed in order of match win percentage.    The report displays 
match wins/losses (M W/L), match win percentage (M Pct), game wins/losses 
(G W/L), game win percentage (G Pct), points for (PF), and points against (PA)
for each of the teams selected.
Points for are the points scored by a team and points against are the points 
allowed by a team.
Win Percentage is computed as ((wins + ties) / total games or matches) 
where wins are 1 point, ties are 1/2 point, and total games/matches are 1 
point per game/match..
Click Print to print the report or save it to a disk file.    Click Compute to 
compute the report for different matches.
To create team standings, game scores by match must be recorded for all 
teams selected.    Only game scores by match are needed to create 
standings.    Date, location, etc., are not needed.    Player results are also not 
needed.    However, each team must be added to StatTrak.    If Team X plays 
Team Y, you must add a match for Team X and add a match for Team Y.    
Match results for both teams can not be added at the same time.    They 
must be added separately.    However, you can add the match for Team X and
then on the Game Screen for Team Y you can select Team X as the opponent 
and then click Import to copy the game screen information that was entered 
for Team X.    Scores and home team will be reversed when imported.



Compute Reports
From ALL StatTrak reports, you can click Compute to recompute the report 
using the following selection criteria on the Compute Screen:

*    Match Range - Any range of match numbers from 1 to 999.
*    Match Types - Any combination of seven match types    (renamed from

Name Your Own).
*    Special Select - Check box to use ONLY Special Selected matches. 

Lets you compute for non-consecutive match numbers (i.e. 1,3,9).    You 
can Special Select matches when updating a match on the Match Screen
or by selecting matches on the Compute Screen.    Selections are saved.

*    Career Statistics - Enter player name or number to compute career 
statistics.    Only available from the Team and Player Statistics Report 
when two or more teams are selected.

Click All from the Compute Screen to reset parameters for computing all 
matches.    Click OK to compute report.



Print Reports
All StatTrak reports (Players, Match Scores, Record, and Standings) can be 
printed or saved to a disk file.
When you print a report, you can either use the default report title or enter 
your own.    You can select from 1 to 50 copies and select the number of lines 
per page.    You can also select the font size for the report title and main body
of the report.    Some printers will not recognize font size but the report will 
still print.    Bold fonts can also be selected.    For the Team and Player 
Statistics Report you can choose to print just the top X number of players 
(i.e. League Leaders Report).
You can choose to create a report disk file instead of printing the report.    
Entering a file name will override printing.    You can specify a path with the 
file name and can either create a new report file, replace a report file, or 
append to an existing one.    Click Find... to search for a file.
Click Setup to bring up the Print Setup Screen to change print parameters 
such as Portrait or Landscape.



Update
To update team, player, and match information, select Update from the Main 
Menu and select one of the following menu options:

Matches - Update team and player results.
Roster - Update player information on roster.
Team Name - Assign or change team name.
Change Player Number - Change player number.
Delete Files - Delete all data files (team name, roster, match 

results, player results) for the selected team.
A team must be selected before the menu options for Update are enabled.    
If more than one team is selected, only the first team selected on the team 
list can be updated.
* See also First Match.



Update Matches
Select Matches from the Update Menu to update match results.    The two 
components in updating a match are the Match Screen and the Player 
Screen.    General match information is (optionally) entered on the Match 
Screen and player results are (optionally) entered on the Player Screen.
After selecting Matches from the Update Menu you will advance to the Match
Menu.    Click Add Match to add a match.    Highlight a match on the Match 
List and click Change to change a match,    click Delete to delete a match, or 
click Insert to insert a match.    You can also double-click a match on the 
Match List to change it.    Clicking Add Match, Change, or Insert will take you 
to the Match Screen.      If you just want to update player results for a match 
already added, you can highlight the match on the Match List and then click 
Player Screen to go directly to the Player Screen.    When you delete a match,
ALL player results recorded for that match will also be deleted (be careful)!
From the Match Screen, you can update match date, location, opponent, 
game scores, home team, Special Select, match type, and comment.    All 
entries on the Match Screen are optional, except match type.    Click OK to 
update match results.    When adding or inserting a match, clicking OK will 
automatically take you to the Player Screen.    However, when changing a 
match, clicking OK will take you back to the Match Menu.    Click Player 
Screen to advance to the Player Screen when changing a match when you 
also want to update player results.
One of seven match types is selected for every match updated (defaults to 
the first match type when adding a match).    Match types can be renamed by
selecting Name Your Own from the Options Menu.    All StatTrak reports can 
be computed by match type.    For example, you could name match type 1 
LEAGUE and match type 2 PRACTICE.    Then you would select the LEAGUE 
match type when updating league matches and the PRACTICE match type 
when updating practice matches.    Then you could compute any report for 
only league matches, only practice matches, or both league and practice 
matches very easily.
If you are tracking statistics or standings for two teams that played each 
other, you don't need to enter the same Match Screen information for both 
teams.    Add the match for one team first.    Then on the Match Screen for the
other team select the opponent and then click Import to initialize the match 
information (date, location, game scores, match comment (optional), match 
type) from what was entered for the other team.    The home team and 
scores will be reversed when imported.
On the Match Screen you can check Special Select which is used in 
computing reports.    For example, you could Special Select home matches 
and then compute any report for home matches.    You can also Special Select
matches from the Compute Screen.



The other component in updating a match is the Player Screen where 
individual player results are entered.    Entering player results is optional.    
You can always add results later.
Click on the Player Table to select a player to update.    The row clicked 
determines which player is selected.    The Stats Area for the player selected 
will be highlighted and the player name will be displayed on the right.    You 
can either enter player results by keying them in or by clicking +1 or -1.    
Using the +1 and -1 command buttons could be used to enter results as the 
match is being played.    A Volleyball Icon on the Player Table indicates player
results have been entered.    Check Played in Match to mark appearance of 
player in match. However, you must enter at least one game played if you 
check Played in Match. Entering games played (G) is important so game 
averages are accurately computed by StatTrak even if games played is the 
only category entered.    Uncheck Played in Match to remove appearance of 
player in match and to zero all entry fields.
NOTE: StatTrak computes player total blocks (Blk) = blocks solo (BS) + block
assists (BA).    However, team total blocks are computed as total blocks (Blk) 
= blocks solo (BS) + (block assists (BA) / 2).    This is because two players can
have an assist on the same block but the team is really only blocking one 
shot. A problem computing team total blocks can occur when three players 
block a shot. This won't be a problem if it only happens once since StatTrak 
drops the remainder ( 3 / 2 = 1). However, if a triple block occurs more than 
once, team total blocks will be slightly overstated. We thought this would be 
better than to have you enter Total Team Blocks on the Player Entry Screen.
If you plan to enter player results real-time (as the match is being played), 
you should periodically save the player results and then return to the Player 
Screen for that match.    Results are not saved until you click OK on the Player
Screen.    It's a little more difficult to update player results for two teams real-
time because you can only work with one team at a time.    However, a future
version of StatTrak for Volleyball will address the issue.
When entering player results you can record results for up to five Name Your 
Own categories.    These category names can be changed by selecting Name 
Your Own from the Options Menu.
Click Roster to add players to the roster.    The total number of players with 
results entered are displayed below the Player Table.
Click Team Totals to display the team totals.    This can be used as an auditing
tool.    Click Match Screen to go to the Match Screen.    Click OK to save all the
player results entered.    Click Cancel to cancel ALL the player results entered
(not the last player entered but ALL the players entered).    Clicking OK or 
Cancel will return you to the Match Menu.
See Team and Player Statistics for a list of all statistics that can be recorded 



and computed by StatTrak for Volleyball.



Update Roster
Select Roster from the Update Menu to set up and maintain a team roster.    
Up to 99 players can be added for each team.    Select from the player list 
and enter or change the name, phone number, address, city, state, zip, and 
other player information.    Click Delete to delete a player name and related 
information from the roster.    Click Print to print the roster information.
Player names have an associated player number from 1 to 99.    One way to 
assign player numbers is to use the player's uniform number.    Currently, the 
only use of the player number is for computing career statistics.    However, 
career statistics can also be computed by player name.    The player number 
is used by StatTrak to identify players and does not appear on any reports.    
Deleting a player or changing a player name has NO effect on results 
recorded for that player number.    Player results relate to the player number, 
NOT the player name.
Don't get hung up on the player number.    It's a throw back from the DOS 
version of StatTrak for Baseball (StatTrak for Volleyball was cloned from 
StatTrak for Baseball) and will probably be eliminated in a future version of 
StatTrak for Volleyball.



Update Team Name
Select Team Name from the Update Menu to assign or change a team name.  
You can assign a long team name and a short team name.    The short team 
name is only used on multiple team player statistics reports.    The long team 
name is used on all other reports and screens.    Click Default to assign the 
default team name based on the team number (i.e. Team 7).    You might 
want to include the year in the team name for documentation purposes (i.e. 
1993 Warriors).    This is especially helpful if you plan to record matches for 
the same team in more than one year.
You might want to assign the team name before you set up the roster or add 
match results to make sure you're working with the correct team.    The team 
name is listed on all update screens.    Changing the team name has NO 
effect on match and player results recorded for that team.    Match and player
results relate to the relative team number, NOT the team name.



Change Player Number
Select Change Player Number from the Update Menu to move a player's 
name and statistics to another player number on the roster.    You can only 
change a player's number if NO results have been recorded for the number 
you want to change to.    This function could be used so a player has the 
same number every year for computing career statistics by player number.    
However, you can also compute career statistics by player name.
Don't get hung up on the player number.    It's a throw back from the DOS 
version of StatTrak for Baseball (StatTrak for Volleyball was cloned from 
StatTrak for Baseball) and will probably be eliminated in a future version of 
StatTrak for Volleyball.



Delete Files
Select Delete Files from the Update Menu to delete the team name, roster, 
match results, and player results for the selected team.    This function could 
be used to delete matches that were added while experimenting with the 
program.
BE VERY CAREFUL USING THIS FUNCTION.    The team name, roster, 
match results, and player results recorded for the selected team will be 
permanently deleted!
Periodically make a backup copy of your match and player files.



Options
Selecting Options from the Main Menu provides the following menu option:

Name Your Own - Name your own match types and categories
The name your own categories are cumulative.    A future version of StatTrak 
for Volleyball will have an additional option to Create Your Own Calculation.



Data Directory
Select Data Directory from the File Menu to select the team and player file 
directory you want to work with.    Each directory can track up to 100 teams.
StatTrak will NOT make a directory for you.    You must do it.



Name Your Own
Select Name Your Own from the Options Menu to name match types and 
additional categories.
With StatTrak every match is assigned a match type.    With Name Your Own 
you can name up to 7 match types.    For example, you could name match 
type 1 LEAGUE and match type 2 PRACTICE.    Then you would select the 
LEAGUE match type when adding league matches and the PRACTICE match 
type when adding practice matches.    You could then compute statistics for 
league matches by only selecting the LEAGUE match type on the Compute 
Screen, practice matches by only selecting the PRACTICE match type, or 
league and practice matches by selecting the LEAGUE and PRACTICE match 
types.    When computing reports, only the relative position of the selected 
match types are important, the names are just labels you assign.
You can also name up to 5 additional categories.    To track service errors 
long, you could name a category SEL and then record results under that 
heading when adding player results.    Then by selecting SEL on the Format 
Screen, you could add SEL to the Team and Player Report.    Naming a 
category is for labeling purposes only.    Statistics relate to the relative 
position of the Name Your Own category, NOT the category name.
The name your own categories are cumulative.    A future version of StatTrak 
for Volleyball will have an additional option to Create Your Own Calculation.
You might want to name your own match types and additional categories 
before you start adding matches.    However, you can name them at any 
time.



Team and Player Statistics
Below is a list of the statistics that are tracked and computed by StatTrak for 
Volleyball:

G            Games Played          Ast        Assists
Srv      Serve Attempts Set      Sets
SP        Service Points                  BS        Blocks Solo
SA        Service Aces        BA        Block Assists
SE        Service Errors                      BE          Blocking Errors
Att        Attack Attempts Dig      Digs
K            Kills RE        Reception Errors
AE        Attack Errors BHE    Ball Handling Errors
Dnk    Dinks
VB1, VB2, VB3, VB4, VB5    User Named Categories (renamable)
M            Matches Played =    number of matches played
SPG    Service Points per Game =    SP / G
Srv% Serve Percentage =    (Srv - SE) / Srv
SAG    Service Aces per Game =    SA / G
Att% Attack Percentage =    (K - AE) / Att
KG        Kills per Game =    K / G
AstG Assists per Game =    Ast / G
Blk      Total Blocks =    BS + BA
BlkG Blocks per Game =    Blk / G
DigG Digs per Game =    Dig / G

NOTE: StatTrak computes player total blocks (Blk) = blocks solo (BS) + block
assists (BA).    However, team total blocks are computed as total blocks (Blk) 
= blocks solo (BS) + (block assists (BA) / 2).    This is because two players can
have an assist on the same block but the team is really only blocking one 
shot. A problem computing team total blocks can occur when three players 
block a shot. This won't be a problem if it only happens once since StatTrak 
drops the remainder ( 3 / 2 = 1). However, if a triple block occurs more than 
once, team total blocks will be slightly overstated. We thought this would be 
better than to have you enter Total Team Blocks on the Player Entry Screen.



Other Programs
Other Windows Programs available from ALL-PRO Software:

* StatTrak for Baseball (and Softball) $39.95
Works very much like StatTrak for Volleyball!
Rated #1 by the Society for American Baseball Research (SABR) software
review.

* StatTrak for Basketball $39.95
* StatTrak for Soccer $39.95
* StatTrak for Hockey $39.95
* ALL-PRO League Scheduler $49.95

Create round-robin schedules in minutes!
Handles division play and tracks scores and standings.

$3.75 shipping and handling per order!

Other Windows Programs soon to be released by ALL-PRO Software:
Release Date

* ALL-PRO Tournament Scheduler January 1st, 1997
* StatTrak for Football July 1st, 1997

To order or for more information, call ALL-PRO Software at 800-SPORT-59 
(MC/Visa).    International orders are welcome - call 608-271-1586!
Check out our Home Page (demos available for downloading):

http://www.msn.fullfeed.com/~allpro/
or Email us:

allpro@msn.fullfeed.com
Let us know what other features and sports programs you would like to see!



Registration
Unless this is a demo (shareware) version of StatTrak for Volleyball, you must
have either purchased it from an authorized retail outlet or directly from ALL-
PRO Software.    Otherwise, you have an illegal copy and must immediately 
register with ALL-PRO Software or delete the program.
To register StatTrak for Volleyball, call ALL-PRO Software at 800-SPORT-59 
(MC/Visa) or send a check or money order for $39.95 + $3.75 shipping and 
handling to ALL-PRO Software.    International orders call 608-271-1586 or 
send a check or money order in U.S. funds drawn on a U.S. bank and use 
$5.00 for shipping and handling.    Wisconsin Residents please add 5.5% sales
tax ($2.20) for a total of $45.90.You will receive the latest version of StatTrak 
for FREE when you register.
To register a retail copy of StatTrak for Volleyball, send the registration card 
or proof of purchase to ALL-PRO Software if you wish to receive the benefits 
listed below.    No fee is required.
If you obtained the program from ALL-PRO Software, you are automatically 
registered and will receive the benefits listed below.
Registration Benefits:

*    You will be notified when major upgrades to StatTrak for Volleyball are 
released.    They will be offered to you at a reduced price.    The program 
will be upgraded every year.

*    You will be notified when other programs are released or upgraded by 
ALL-PRO Software.

* You can receive FREE technical support at 608-271-1586.    Please don't 
use the 800 number for technical support.    The 800 number is for orders 
only.    Thank you!



Technical Support
For technical support:

* Call us at 608-271-1586.    Please don't use the 800 number for technical 
support.    The 800 number is for orders only.    Thank you!

* Fax us at 608-277-9195.
* Write us at All-Pro Software, 30 Maple View Court, Madison, WI 53719
* Email us at allpro@msn.fullfeed.com



License
THIS SOFTWARE IS PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER 
EXPRESS OR IMPLIED, INCLUDING ITS MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE.      NEITHER ALL-PRO SOFTWARE NOR ANYONE ELSE 
INVOLVED IN CREATING, PRODUCING OR DELIVERING THIS SOFTWARE SHALL BE 
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL OR CONSEQUENTIAL 
DAMAGES ARISING OUT OF USE OF THIS SOFTWARE OR INABILITY TO USE THIS 
SOFTWARE.      IN NO EVENT SHALL ALL-PRO SOFTWARE'S LIABILITY FOR ANY 
DAMAGES EVER EXCEED THE REGISTRATION FEE, REGARDLESS OF THE FORM OF 
CLAIM.    THE ENTIRE RISK AS TO QUALITY AND PERFORMANCE IS WITH THE USER.
THIS AGREEMENT SHALL BE GOVERNED BY THE LAWS OF THE STATE OF WISCONSIN 
AND SHALL INURE TO THE BENEFIT OF ALL-PRO SOFTWARE.    ANY ACTION OR 
PROCEEDING BROUGHT BY EITHER PARTY AGAINST THE OTHER ARISING OUT OF OR 
RELATED TO THIS AGREEMENT SHALL BE BROUGHT ONLY IN A STATE OR FEDERAL 
COURT OF COMPETENT JURISDICTION LOCATED IN DANE COUNTY, WISCONSIN.    THE
PARTIES HEREBY CONSENT TO JURISDICTION OF SAID COURTS. 
THIS SOFTWARE AND THE DISKS ON WHICH IT IS CONTAINED IS LICENSED SOLELY 
TO YOU ON A PERPETUAL BASIS FOR YOUR OWN USE. THIS IS COPYRIGHTED 
SOFTWARE.    YOU ARE NOT OBTAINING TITLE TO THE SOFTWARE OR ANY 
COPYRIGHT RIGHTS.    YOU MAY NOT SUBLICENSE, RENT, LEASE, CONVEY, MODIFY, 
TRANSLATE, CONVERT TO ANOTHER PROGRAMMING LANGUAGE, DECOMPILE, OR 
DISASSEMBLE THE SOFTWARE FOR ANY PURPOSE.    RECEIPT AND USE OF THE 
PRODUCT IS YOUR AGREEMENT TO THE TERMS OF THIS LICENSE.




